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          Twin Tec User Instructions for 
Twin Tuner EX 

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING. 

OVERVIEW 
The Twin Tuner EX is 50 states street legal 

(ARB E.O. No. D-641) for 2001-2008 H-D® Twin Cam 
models with the 36 pin Delphi® module. The Twin 
Tuner EX is not compatible with 2008 touring models 
with electronic throttle control. Fuel adjustments with 
the Twin Tuner EX version are only allowed above 
60% throttle position or 5000 RPM. You can add or 
subtract fuel. 

Installation takes only 10-15 minutes and is very 
easy, with no splicing, cutting, crimping, or bulky 
interconnections. All access is at the Delphi ECM. Just 
remove five wires from the ECM connector, insert 
these wires into our small mating connector, insert five 
new wires from the Twin Tuner EX into the ECM 
connector, and connect one ground wire. The unit is 
completely encapsulated and impervious to moisture. 
With a very low profile of only ½” and occupying a 
fraction of the space required by competitive products, 
you won’t have a problem finding a place to mount the 
unit.  

Figure 1 – Twin Tuner EX 

 
You can use the mode and up/down pushbutton 

switches to make fuel trim adjustments in the RPM and 
throttle position ranges required by most applications. 
The fuel trim value is displayed on a bright daylight 
readable LED display.  

The Twin Tuner EX also has an advanced 
mode, where you can use the optional USB interface 

and PC Link Tuner software to make precise fuel 
adjustments. The PC Link Tuner software uses the 
same RPM rows and throttle position columns as the 
Dynojet Power Commander. If you have created  
Dynojet Power Commander files for your applications, 
you can use the same values in our tables. You can 
make independent adjustments to the front and rear 
cylinders. 

INSTALLATION 
1. If the motorcycle is equipped with a security 

system (TSSM module), make sure the system is 
disarmed. Turn off the ignition switch and 
disconnect the battery ground cable before 
proceeding. 

2. Find the Delphi® engine control module (ECM). 
The ECM is usually located under the seat or 
under a side cover. 

3. Unplug the ECM connector. Cut the cable tie that 
secures the wire conduit. Use a small flat 
screwdriver to depress the tabs on the side of the 
connector and remove the clear plastic retainer as 
shown in Figure 2.  

4. Use a small flat screwdriver to gently pry up the 
three locking tabs and separate the connector 
halves as shown in Figure 3.  

5. Refer to Table 1 for connection details. Remove 
five wires from the ECM connector (these will later 
be inserted into the Deutsch plug supplied with the 
Twin Tuner EX). 

6. To release terminals from the ECM connector, use 
a small screwdriver to gently lift up the terminal 
and retaining tab while pulling on the wire as 
shown in Figure 4.  
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Figure 2 – ECM Connector Retainer Removal 

 

Figure 3 – ECM Connector Disassembly 

 

Figure 4 – ECM Connector Terminal Removal 

 

Figure 5 – Completed Wiring at ECM 

 
7. Terminal numbers are marked on the back side of 

the ECM connector. Original equipment wire color 
codes may vary. Note the color of each wire that 
you remove. We suggest that you mark up Table 1  
with any corrections for future reference.  

8. Refer to Table 1 and install the five wires from the 
Twin Tuner EX into the ECM connector.  

9. Use a small side cutter to make a slit in the cable 
conduit so that the five wires you removed can exit 
as shown in Figure 5. Wrap electrical tape around 
the cable conduit. Reassemble the ECM 
connector. Secure the cable conduit with a 
supplied cable tie. 

10. Refer to Table 1 and install the five wires removed 
from the ECM connector into the supplied Deutsch 
plug (#1 In Figure 5). Terminal numbers are 
marked on the back side of the Deutsch plug. 
Install the orange secondary lock. Wrap the wires 
with electrical tape as shown in Figure 5.  

11. Plug the ECM connector back onto the ECM. 
Connect the Deutsch plug from the ECM harness 
to the mating Deutsch receptacle on the Twin 
Tuner EX harness as shown in Figure 5. 

12. Connect the Twin Tuner EX black ground wire to 
an appropriate ground. You can generally find one 
or more screws used for other ground connections 
under the seat or near the ECM.  

13. The Twin Tuner EX brown wire with Weather Pack 
connector is the data link used for PC 
communications. If not used,  tape up this wire.  

14. Find a location for the Twin Tuner EX. You can use 
Velcro material to secure the unit. 

15.  Reconnect the battery ground cable. Do not 
attempt to start the engine until you have 
completed the initial setup.  
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Table 1 – Wiring Hookup 

Twin Tuner EX Wires 

Wire Color To ECM Connector  Signal 

Blue 3 Tach 

White 13 Ignition Switch  

Red 19 Rear Injector  

Orange 21 Front Injector 

Violet 24 Throttle Position Sensor 

   

ECM Wires (removed from ECM connector) 

Wire Color (ECM terminal) To Deutsch Plug #1 Signal 

White/Black (13) 1 Ignition Switch 

Pink (3) 2 (not used on some models) Tach 

Gray/Violet (24) 3 Throttle Position Sensor 

White/Yellow (21) 4 Front Injector 

Green/Gray (19) 5 Rear Injector 

 

INITIAL SETUP   
The Twin Tuner EX has a 10 position rotary 

mode switch used to select fuel trim parameters to edit, 
two digit LED display, and up/down pushbutton 
switches to change the parameter value. Fuel trim 
parameters are listed in Table 2. Note that the 
rectangular LED to the left of the two digit LED is 
illuminated for negative values. Values represent 
percent fuel trim. You can use a small flat screwdriver 
to rotate the mode switch. You can make parameter 
changes on-the-fly with the engine running.   

Before starting the engine for the first time, turn 
the ignition switch and run/stop switch on. The idle air 
control motor will move to the starting position and the 
fuel pump will be energized for several seconds, 
making an audible buzz. Set the mode switch from 
each position from 0 to 9. The LED display should be 
off in position 0. The LED display should illuminate and 
read 00 in positions 1-9 (unless your Twin Tuner EX 
has been preprogrammed for some specific 
application). If required, use the up/down pushbuttons 
to set the values for each position to zero. Start the 
engine and verify normal operation. If the engine will 
not start, or runs on one cylinder, recheck connections.  

BASIC TUNING   
Table 2 shows the engine operating ranges 

affected by fuel trim values in terms of RPM and 
throttle position sensor (TPS) values. To properly tune 
an engine, you need to know what fuel trim values are 

required. The only practical means of doing so is to 
use an air/fuel ratio (AFR) metering system based on a 
wide-band oxygen sensor, either directly mounted in 
the exhaust or as part of an exhaust sniffer. It is 
impossible to make accurate adjustments by seat-of-
the-pants or reading spark plugs. For models with 
original equipment oxygen sensors, please read the 
section on page 9. 

If you do not have access to an AFR metering 
system, you can still make some adjustments based on 
the following guidelines.  

1. If the engine runs rough or hesitates under wide 
open throttle acceleration, try adding 5-10% fuel in 
the RPM ranges where problems are noted 
(parameters 1-7). 

2. If throttle roll-on response is poor, try adding some 
acceleration enrichment (parameter 9).    
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Table 2 – Mode Switch Settings 

Parameter Fuel Trim Operating Range 
0 Display off – used to prevent inadvertent changes during normal engine operation 

1 Wide open throttle 1250-2000 RPM 60-100% TPS 

2 Wide open throttle 2000-2500 RPM 60-100% TPS 

3 Wide open throttle 2500-3000 RPM 60-100% TPS 

4 Wide open throttle 3000-4000 RPM 60-100% TPS 

5 Wide open throttle 4000-5000 RPM 60-100% TPS 

6 Wide open throttle 5000-6000 RPM 60-100% TPS 

7 Wide open throttle above 6000 RPM 60-100% TPS 

8 Entire operating range above 5000 RPM 0-60% TPS 

9 Acceleration enrichment above 5000 RPM or 60% TPS (0 = none, 10 = maximum) 

 

If you have access to an AFR metering system, 
either a standalone system or as part of a load control 
dyno with an exhaust sniffer, you are in a much better 
position to make accurate adjustments.  

1. Make sure the engine is fully warmed up and has 
reached normal operating temperature. Run the 
engine at part throttle above 5000 RPM. If the 
observed AFR values are excessively rich or lean, 
make appropriate adjustments to parameter 8.  

2. Do acceleration runs at wide open throttle while 
recording the AFR. Target AFR values at wide 
open throttle are in the 12.8-13.0 range. Refer to 
Table 2 and make appropriate fuel trim 
adjustments in each RPM range (parameters 1-7).  

3. If throttle roll-on response is poor or a lean 
transient (high AFR values) is observed, try adding 
some acceleration enrichment (parameter 9).    

 ADVANCED TUNING   
The Twin Tuner EX also has an advanced 

mode, where you can use the optional USB interface 
and Windows software to check and observe system 
operation (Tuner Log) and make precise fuel 
adjustments (PC Link Tuner).  

PC REQUIREMENTS 
The Twin Tuner EX connects to your PC by 

means of an optional USB interface (P/N USB-INTF) 
that is also used with our other engine controls. The 
PC must have a free USB port. If you have an older PC 
without USB capability, you cannot use the advanced 
tuning capability.  

We recommend a laptop PC with Pentium 
processor and super VGA display (SVGA with 1024 x 
768 pixel resolution) running Windows 98/ME/XP/Vista. 

Data display is graphics intensive and a high speed 
Pentium processor is recommended. Processors 
slower than 300 MHz will exhibit sluggish program 
loading and response. The PC must have a CDROM 
drive for program loading.  

PC Link Tuner software includes print 
commands to print downloaded data. The program has 
been tested with Hewlett-Packard laser and inkjet 
printers and Epson inkjet printers. We recommend 
using a color inkjet printer. 

SOFTWARE INSTALLATION 
The software is supplied on CDROM media or in 

the form of a compressed file downloaded from our 
website. The installation process uses InstallShield. 
This industry standard installer is based the new 
Microsoft Windows Installer service that greatly 
reduces potential problems such as version conflicts 
and allows for application self-repair. Since Windows 
98 systems did not originally include the Windows 
Installer service, the required installer software is 
included in the distribution media.  

There are two programs to install: Tuner Log and 
PC Link Tuner. Start by installing Tuner Log. If you are 
downloading software from the web, only download and 
install one program at a time. Before proceeding with 
installation, shutdown any other applications that may be 
running. For Windows Vista, you must disable the User 
Account Control (UAC) during installation. If you are 
not familiar with the UAC, please refer to the Vista 
UAC Tech Note on our website's Tech FAQ for details. 

Use the Windows Explorer or the Run command 
from the Windows Start Menu to launch setup.exe in the 
Tuner_Log  folder on the CDROM or the setup.exe file 
downloaded from our website. InstallShield will install the 
software in an appropriate folder under Program Files. 
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Repeat the installation process for PC Link Tuner. 
Use the Windows Explorer or the Run command from 
the Windows Start Menu to launch setup.exe in the 
PC_Link_Tuner  folder on the CDROM or the setup.exe 
file downloaded from our website. InstallShield will install 
the software in an appropriate folder under Program 
Files. 

Once InstallShield has completed the 
installation, Tuner Log and PC Link Tuner will appear 
on the Windows Start Menu. You can then launch them 
just as you would any other Windows program.  

PC Link Tuner software requires the Monospace 
821 BT fixed pitch printer font in order to properly align 
columns when printing. The Monospace 821 BT font is 
included in the distribution media and automatically 
copied to your Windows Fonts folder during 
installation. A backup copy is also placed in the 
program folder. If you accidentally delete this font, use 
the Install New Font command from the Fonts folder 
File menu. The filename associated with Monospace 
821 BT is monos.ttf. 

TWIN TUNER EX CONNECTION  
Follow the instructions supplied with the optional 

USB interface to install the required USB drivers and 
configure the COM port. Once you have configured a 
COM port number for your new USB Interface, make 
sure that you use this same COM port selection in the 
Tuner Log and PC Link Tuner software. Use the 
“TC88A AND ALL OTHERS” switch setting. 

An adapter harness is supplied with the USB 
Interface for use with the Twin Tuner EX. Connect the 
alligator clip on the black wire to ground and the 
Packard Weather Pack connector to the mating 
connector on the brown wire from the Twin Tuner EX.  

Turn the ignition key and engine run/stop switch 
on to provide power to the system. Do not start the 

engine if you want to download or upload data with PC 
Link Tuner. 

TUNER LOG SOFTWARE 
When the engine is running, you can display real 

time engine data on an instrument panel type screen 
as shown in Figure 6 by using the View Real Time 
Data command on the View menu.  

You can also check proper operation of the 
throttle position sensor (TPS) when the run/stop switch 
is on (engine not running). Rotate the throttle through 
the full range of motion. The TPS% value should go 
from zero to 100%.   

Real time engine data is displayed on an 
instrument panel type layout with a round tach gauge 
and bar graph type gauges for all other parameters. 
Status messages are displayed in a separate window. 
If the engine is not running, most values will appear as 
zero or off. 

Displayed parameters include: 

RPM – engine crankshaft RPM (numeric value 
displayed beneath gauge) 

TPS – throttle position (0 to 100%) 

BAT – battery voltage 

FRONT INJ PW, REAR INJ PW – injector pulse 
width in milliseconds (pulse width commanded 
by ECM before fuel trim by Twin Tuner EX) 

FRONT FUEL%, REAR FUEL% – fuel trim in 
percent (0% means no change) 

STATUS – engine running status and basic 
mode (switch settings used to trim fuel) or 
advanced mode (PC Link Tuner tables used to 
trim fuel) 
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Figure 6 – Real Time Engine Data Display 

 
 

PC LINK TUNER SOFTWARE 
Before the engine is started, you can download 

or upload data with PC Link Tuner.  

After PC Link Tuner is launched, the main 
screen appears blank. You have two options for 
obtaining data for editing. You can open a previously 
saved data file by using the Open File command on the 
File menu or you can download data from an attached 
Twin Tuner EX unit by using the Download Data From 
Twin Tuner EX command on the Communications 
menu. Note that Twin Tuner EX data files use a .dat 
extension. You should create a separate folder to store 
these files.   

Once you have Twin Tuner EX data, you can 
edit various 3D tables and parameters. PC Link Tuner 
software supports both the race and EX versions of the 
Twin Tuner. Some functions and edits outside the 
allowed table areas are restricted when used with the 
Twin Tuner EX.  

3D fuel trim tables are accompanied by chart 
displays that help visualize the data. You can also 
rotate the 3D chart display for a better view of a 
particular region. You can print the data associated 

with an active table or Twin Tuner EX parameters by 
using the appropriate Print command from the File 
menu. When you open a file or download data from a 
Twin Tuner EX, the data is stored in a buffer memory. 
After editing a table, you can save the edits to this 
buffer memory. Once you have completed all your 
edits, you can save the data in buffer memory to a file 
or upload it back to the Twin Tuner EX by using the 
appropriate command from the File or Communications 
menu. 

Please note that communication is only possible 
if the ignition key and run/stop switch are turned on 
and the engine has not yet been started.  

TWIN TUNER EX PARAMETERS  
Twin Tuner EX parameters shown in Figure 7 

control the overall operating mode of the unit and allow 
you to preset parameters without using the switches on 
the unit. Options and parameters that you can set 
include: 

Twin Tuner Version  – when a file is opened or 
data is downloaded, the software automatically 
determines the Twin Tuner version. Race version data 
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can be converted to the EX version format by clicking 
on the EX Version option button. Some functions and 
edits outside the allowed table areas are then 
restricted. Data formatted for the EX version cannot be 
converted back to the race version. 

Basic Mode – fuel trim values are based on 
switch settings. This is the default operating mode. 

Advanced Mode – fuel trim values are based 
on the 3D front and rear cylinder fuel trim tables.  

Injector Swap on Enrichment Mode – this 
mode is not available for the EX version and the 
checkbox is grayed out.   

Enable Manual Trim in Advanced Mode – this 
option is only available in advanced mode and is 
grayed out in basic mode. If this option is selected, 
switch settings 1 to 8 can be used to manually trim the 
3D fuel tables. If this option is not selected, switch 
settings 1 to 8 are ignored (switch setting 9 for 
acceleration enrichment is still active). 

Parameters 1-9 – display fuel trim parameter 
values. Can be used to edit or preset values without 
using the switches on the unit. Fuel trim parameters 
are listed in Table 2.   

User Data – you can enter up to 32 characters 
of user data that will be saved in EEPROM memory. 
User data can contain comments or serial numbers. 

Figure 7 – Twin Tuner EX Parameters 

 

 
EDITING 3D TABLE DATA  

You can edit the front and rear cylinder fuel trim 
tables. Before you can edit one of these tables you 
must either open a data file or download data from a 
Twin Tuner EX unit. Numeric data is always edited on 
the spreadsheet grid. The front and rear cylinder fuel 

trim tables are accompanied by 3D graphs that help 
visualize the data.  

Each table consists of 18 rows from 500 to 
6,500 RPM and 9 throttle position columns from 0% to 
100%. The 6,500 RPM value is used at all higher RPM 
levels. 
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After you have edited a table, you must use the 
Save Table Edits To Buffer command from the Edit 
menu to save your edits to buffer memory. If you use 
the Close Table command from the Edit menu, all your 
edits are lost.   

Front and Rear Cylinder Fuel Trim Tables 
The fuel trim values in these tables are only 

active if advanced mode is selected. You can enter fuel 
trim values from -20% to +30%. Restricted cells (less 
than 60% TPS and less then 5000 RPM) appear in red. 

All fuel trim values in these restricted cells are zero and 
cannot be edited. An error message will appear if you 
attempt to edit any of the red cells. Unless you have 
specific experience in trimming individual cylinders and 
the associated fuel distribution problems, we suggest 
that you use the same values for both front and rear 
cylinders. You can edit a table for the front cylinder. 
After saving the table edits to buffer memory, you can 
use the Copy Front Cylinder Trim to Rear command 
from the Edit menu to quickly copy the entire table. 

 

Figure 8 – Typical Front Cylinder Fuel Trim Table 

 

 
Editing Table Data 

You can edit table data using standard Windows 
copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command as shown in Figure 9.   

 

Figure 9 – Modify Command  
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Data Export and Import by Means of Copy 
and Paste 

You might want to export or import 3D table data 
to or from another application such as Microsoft Excel 
and other programs with tables that support copy and 
paste operations. You can directly copy and paste data 
to and from the PC Link Tuner program. In the PC Link 
Tuner program, you can select a range of cells with the 
mouse and right click to bring up a copy and paste 
menu. When you paste data into the PC Link Tuner 
program, the data is automatically checked and any 
out-of-range data corrected.  

Chart Operations 
You can rotate the 3D chart display for a better 

view of a particular region by dragging the mouse while 
holding both mouse buttons down.  

PC Link Tuner is intended to be an open system 
and uses the Component One Chart 7.0 3D charting 
control. The adventurous user can experiment with the 
chart property pages by right clicking on the chart. 
Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link Tuner.  

MODELS WITH ORIGINAL 
EQUIPMENT OXYGEN SENSORS 

2006 fuel injected Dyna and all 2007-2008 
models are equipped with dual narrow-band oxygen 
sensors and a Delphi® ECM that supports closed loop 
AFR control based on feedback from the sensors. After 
the engine has warmed up, the ECM attempts to 
maintain the AFR at 14.6 during idle and part throttle 
cruise. Several factors must be considered when 
modifying engines equipped with this system: 

1. If installation of an aftermarket exhaust is planned, 
it must have provision for the oxygen sensors.  

2. At idle and part throttle, the ECM can automatically 
correct for modifications by changing the baseline 
fuel up to ±25%. You can use a scan tool to check 
what correction the ECM is making under closed 
loop conditions (original equipment narrow-band 
sensors must be installed). The correction is 
referred to as the error integrator value and will 
range from 75-125%. If the ECM is running out of 
adjustment range, you may be able to use the Twin 
Tuner EX to trim the baseline fuel delivery above 
5000 RPM (parameter 8) in order to bring the error 
integrator value back to near 100%. However, you 
will not be able to change the target AFR value. 
This will always remain at 14.6.     

3. You can use the Twin Tuner EX to make 
corrections at wide open throttle (parameters 1-7) 
just as you would with earlier models not using 
oxygen sensors.  

USING DYNOJET POWER 
COMMANDER TUNING DATA 

If you have created Dynojet Power Commander 
files for your applications, you can use the same 
values in our tables. Remember that with the Twin 
Tuner EX, you can only edit the cells above 60% TPS 
or 5000 RPM. A typical Power Commander fuel table is 
shown in Figure 10. The TPS columns are the same as 
used in our tables and the RPM rows are very similar. 
For intermediate RPM rows in our tables, such as 
1,250 RPM, you can enter values approximately in 
between the values in the Power Commander 1,000 
and 1,500 RPM rows. For Power Commander files that 
have a single fuel table, use the same values for both 
cylinders with the Twin Tuner EX.  
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Figure 10 – Typical Dynojet Power Commander Fuel Table 

 


